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ENO PROMISES INCREASE 
IN SUPERVILLAINY 

 
“Twice the crime in half the time.” 
ROCKET CITY – Local self-proclaimed evil 
supergenius Clayton Eno made a public 
statement yesterday regarding crime in Rocket 
City and his role in it.  In his statement, Mr. 
Eno said:  “I know I’ve been coasting a little 
on my reputation as a supervillain, and I just 
want to reassure residents of Rocket City that 
I’m redoubling my efforts to keep this city in 
the grip of criminal mayhem.  Citizens can 
look forward to sleepless nights trembling in 
fear in their beds wondering what nefarious 
deeds I have up my crooked sleeve.” 

City police were quick to downplay Mr. 
Eno’s statement.  “We’re well aware of Mr. 
Eno’s comments, and while we do take them 
seriously, we are fully prepared and we are 
taking measures,” said a police spokesman.  
When asked about what measures were being 

taken, the spokesman answered, “Well, num-
ber one we’re going to call Future Boy.  So 
far we haven’t seen a need for a number 
two.” 

Following his statement Mr. Eno was 
promptly captured by Future Boy during a 
botched armored car heist.  (see story, City Sec-
tion, page 2) 

 
 
FUTURE BOY KEEPS CITY 
SAFE FROM EVILDOERS 
ROCKET CITY – In recent months the city 
has seen a marked decrease in crime thanks to 
the tireless efforts of Rocket City’s own Fu-
ture Boy.  Since the start of the year Future 
Boy has put not only Clayton Eno behind 
bars, but also a host of minor-league crooks.  
Most recently, the ubiquitous superhero 
bagged prominent criminals The Bamboozler, 
Mr. Proletariat, and The Knee. 

Of these other, lesser-known scofflaws, 
Clayton Eno—en route to Shankrock 
Prison—was quoted as saying, “Wannabes, all 
of ‘em.” 

Rocket City police were overheard com-
menting, “Sure, we should probably be telling 
Future Boy to just let us do our job and han-
dle the policework.  But if he wants to do our 
job for us, you’re not going to hear us com-
plaining.” 

Future Boy was off fighting further crime 
and was unavailable for comment. 
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Weather: 

Partly sunny, with 
rain showers, ending 
overnight or early 
tomorrow morning. 
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CITY 
 

ENO HEIST FOILED 
An armored car heist engineered by local su-
pervillain Clayton Eno was stopped yesterday 
thanks to the efforts of Future Boy.  Eno and 
two co-perpetrators wearing ski masks at-
tempted to rob the armored car with a com-
bination of road spikes, contact explosives, 
and knockout gas. 

While Future Boy was subduing Clayton 
Eno, his two accomplices—a red-headed 
woman and a larger male suspect—reportedly 
slipped away.  Rocket City police arrived on 
the scene shortly thereafter, where they found 
Eno dazed, confused, and lying on the 
ground beside the armored car, muttering 
into a radio (which eyewitnesses later con-
firmed was in fact only a rubber boot), 

“Come back, come back you ungrateful cow-
ards, come back here and get me.” 
 

Strange Lights Puzzle City 
A strange glow in the sky above Rocket City 
late last night brought numerous calls to city 
police, as well as local media outlets including 
this newspaper.  Eyewitnesses report seeing a 
bright, bluish light in the night sky over 
Rocket City Park in the southeast corner of 
the city.  A spokesperson for the Rocket City 
Police Department said, “Despite the fact 
that our officers on duty were fully awake and 
certainly not sleeping through the night shift, 
they did not see anything to confirm these 
reports.” 

 
 
BRIDGE DEBATE DRAGS ON 
The Rocket City Bridge Maintenance Com-
mittee is once again meeting with criticism 
over what detractors are calling a “lack of op-
tions”.  Said one member of the Coalition 
Representing Non-Bridge Option Believers 
(CORNBOB):  “I don’t know what they’re 
thinking:  anything happens to that bridge to 
make it inaccessible, and we’re all stuck here.  
There’s no other way in or out of the city.” 

The Bridge Maintenance Committee is 
scheduled to meet again at the start of next 
week.  There is no word yet from 
CORNBOB as to whether they plan to send 
any representatives. 
 

TODAY’S ROCKET CITY CITIZEN POLL 
Where is Future Boy from? 
o Outer space 
o Rocket City born-and-raised 
o Quebec 

Study Reveals Lukewarm Year For Crime 
A year-long study by researchers at Rocket 
City State University has concluded that it has 
indeed been a less than stellar twelve months 
for those hoping to make a living in pursuit 
of spoils, booty, and other ill-gotten gains.  
Reasons cited for the marked decline include 
luck, Future Boy, and unseasonably warm 
temperatures leading to general ennui in the 
criminal community.  Following is an excerpt 
from the detailed statistical analysis contained 
in the study: 
 

 
 

0% 20% 40% 60% 80% 100%

Future Boy Evildoers

 
Chart:  Future Boy vs. Evildoers 
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COMPUTERS & TECHNOLOGY 
 

Operating system Recommended/supported versions Graphics Sound/music Video 

 Windows 
Windows XP or later recommended; 95, 98, 
ME, 2000 also supported. DirectX 6 or later 
required. 

Yes Yes Yes 

 Macintosh 
Mac OS X 10.2 or later recommended; Mac 
OS 9.1 or later also supported. Quicktime 5 
or later required. 

Yes Yes Yes 

 Linux 
X11 or console; source and compiled x86 
binaries are available.  wxGTK 2.4.0 or later 
required for X11. 

Yes Yes No 

 BeOS 
BeOS R5 recommended; R4.5 also sup-
ported. Yes Yes Yes 

 Palm Palm OS 3.5 or later required. No No No 

 Windows 
CE/Pocket PC 

Pocket PC 2000 or later required.  ARM, 
MIPS, and SH3 processors supported. Yes* No No 

*Additional memory required 
 
Additional requirements and 
recommendations: 
• 64MB required for most operating systems; 

128MB or more recommended (excluding 
portable devices) 

• CD-ROM required for installation 
• up to 250MB hard disk space required for 

full installation (or play from CD-ROM) 

• 16MB video card with 800x600 resolution 
and 24-bit color or better recommended for 
graphics 

• 350 MHz processor or better recommended 
for video playback 

• 16-bit sound card or better recommended for 
sound/music 

• mouse recommended for Windows, Macin-
tosh, BeOS, and X11 

 
Installation: 

Installing Future Boy! on any platform gen-
erally involves two steps:  (1) installation of 
the game data, and (2) installation of the ap-
propriate version of the Hugo Engine for 
your platform.   

Please see the following for more detailed 
installation instructions for your system: 

 
 Windows 
Insert the Future Boy! CD-ROM into the 

CD-ROM drive.  If the Setup program does 
not launch automatically, navigate to the 
Windows folder on the CD-ROM and dou-
ble-click the program FBSetup.exe.  The 
Setup program will guide you through the 

installation of Future Boy! (including the Hugo 
Engine).  You may select between a Full In-
stall (of all game data; highly recommended) 
or a Minimal Install (requiring the CD-ROM 
for subsequent play). 

If you do not have DirectX 6 or later in-
stalled, you should follow the instructions to 
install DirectX, as well.  If you already have 
DirectX 6 or later installed, it is not necessary 
to install DirectX. 

When installation is complete, you can 
launch Future Boy! from the Windows “Start” 
menu. 
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 Macintosh 
Run the Install Future Boy! program 

from the Macintosh folder on the Future Boy! 
CD-ROM.  You may select between a Full 
Install (of all game data; highly recom-
mended) or a Minimal Install (requiring the 
CD-ROM for subsequent play).  QuickTime 5 
or later is required. 

When installation is complete, you can 
launch the Future Boy! from the newly created 
game folder. 

 
 Linux 
With the CD-ROM mounted, type the 

following from a command shell window: 
sh /mnt/cdrom/linux/install.sh 

[--minimal | --full] 
[--cdrom=<cdrom-path>] 
[targetdir] 

(all on one line).  The default is Full Installa-
tion (of all game data; highly recommended) 
if a Minimal Install (requiring the CD-ROM 
for subsequent play) is not specified.  You 
may need to supply the CD-ROM path (i.e., 
/mnt/cdrom, or whatever is appropriate for 
your system).  The target directory is optional 
and defaults to your home directory if not 
given.  The directory <targetdir>/fboy will 
be created during installation. 

You’ll also need to install the Hugo En-
gine to play the game.  You can use either the 
precompiled binary (in the bin subdirectory 
of the Linux folder on the CD-ROM) or 
compile it from source (in the src subdirec-
tory)  You will also need to install the Mik-
Mod and wxGTK libraries, both of which are 
provided in the lib subdirectory. 

(For text-only play, however, you need 
only the console-mode Hugo Engine and the 
file future.hex from the Game directory on 
the CD-ROM.) 

 
 BeOS 

Double-click the file Install Future 
Boy!.pkg in the BeOS folder on the CD-
ROM.  (If it doesn’t open automatically, use 
the system utility SoftwareValet.)  You may 

select between a Full Install (of all game data) 
or a Minimal Install (requiring the CD-ROM 
for subsequent play). 

When installation is complete, you can 
launch the game by double-clicking the Future 
Boy! icon in the newly created game folder. 

 
 Palm 

Transfer the files future.pdb and palm-
hugo.prc from the Palm folder on the Future 
Boy! CD-ROM to the device.  Then, on the 
device, launch the Hugo application and 
choose “Future Boy!” from the list of avail-
able games. 
 

 Windows CE/Pocket PC 
Run Setup.exe from the Pocket PC 

folder  on the Future Boy! CD-ROM to install 
PocketHugo on your device.  (Non-Windows 
users should manually transfer the appropri-
ate .CAB file for the device’s processor type 
(ARM/MIPS/SH3) to the device and open it 
using File Explorer.)  Then, transfer the file 
future.hex from the Game folder on the 
CD-ROM to the device’s Documents folder.  
Launch PocketHugo and select “Future Boy!” 
from the list of available games. 
 
Other 

Future Boy! is playable on many more 
computer platforms and operating systems 
than those “officially supported” by the game.  
In fact, any platform for which a recent ver-
sion of the Hugo Engine is available should 
be capable of playing the game.  See 
www.generalcoffee.com/futureboy for more infor-
mation. 

You will first need to install a supported 
version (v3.1 or later) of the Hugo Engine for 
your platform.  While it is possible to play 
Future Boy! from the game’s CD-ROM, it is 
recommended that you copy the game data 
from the Game directory on the CD-ROM to 
a directory on your hard disk.  If you are play-
ing with a text-only version of Hugo, how-
ever, you will only need the file future.hex. 
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Additional Setup: 

Future Boy! provides a number of ways to 
customize your game settings for the best 
playing experience.  The Options menu (se-
lectable from the main menu, or by typing 
“options”) can be used to configure various 
settings.  Conversations can be set to enable 
(the default) or disable menus to control how 
in-game dialogue is handled when you at-
tempt to “talk to someone”.  Game colors 
can be turned on or off; when they are turned 
off, the display uses the Hugo Engine’s color 
scheme instead of the game’s.  On systems 
that support video playback, Play movies will 
turn in-game cinematics (as well as back-
ground video) on or off.  On systems that 
support menu variations, the Menu type can 
be changed from clickable menus to num-
bered, typing-controlled menus.  And the 
built-in Save Reminder can be set (or turned 
off) to control prompting to save your game 
after a number of turns.  (Further configura-

tion of the game, detailed under Other op-
tions can be managed directly from the 
player input line.) 

In addition to the game-level configura-
tion, on some platforms it is possible to cus-
tomize to some degree the operation of the 
playing environment (i.e., the Hugo Engine).  
These platform-specific settings vary from 
system to system, but generally involve de-
fault colors, fonts, and other program inter-
face configuration.  Depending on its capa-
bilities, a port may provide a means of ena-
bling or disabling graphics or video, turning 
sound on or off, etc.  Some ports provide for 
graphics smoothing, which increases the qual-
ity of graphics scaling but may reduce per-
formance.  For further information, read any 
additional provided materials in the folder for 
your system on the CD-ROM, and explore 
the Options or Setup menu of the Hugo En-
gine (where applicable). 

 
Basic Questions and Answers: 
What is “Hugo” or the “Hugo Engine”? 
Hugo is the development system used to cre-
ate Future Boy! (www.generalcoffee.com/hugo).  The 
Hugo Engine is the program  which runs the 
game itself—in a way, it’s similar to a web 
browser that loads and displays web pages.  
This is how Future Boy! can be played on any 
computer system or device which can run the 
Hugo Engine. 
 
What is the difference between Hugo Engine settings 
(from the program menu, where appropriate) and Fu-
ture Boy! options (from the Game Options menu in 
the game itself)? 
The easiest way to think of the difference is 
that Hugo Engine settings affect how the 
program displays or operates, while the Game 
Options affect what the game does.  For in-
stance, depending on your platform, Hugo 
Engine settings may allow you to turn graph-
ics on or off or choose the display font, while 
Game Options affect such things as whether 
in-game cinematic movies will be played or 
what style of menu to use. 
 

Can Future Boy! and other programs run at the 
same time? 
Generally speaking, for multitasking platforms 
(such as Windows, Macintosh, and others), 
the answer is yes.  However, for optimal per-
formance (particularly with regard to media 
such as images, sounds, music, and video), 
make sure that no other applications are run-
ning at the same time as Future Boy!. 
 
What screen resolution does Future Boy! run at? 
Future Boy! and the Hugo Engine do not ac-
tively change the display resolution a user has 
chosen; the game will attempt to adapt to run 
at any resolution or, where applicable, win-
dow size.  However, the recommended reso-
lution for playing with graphical capabilities is 
full-screen 800x600 pixels (or, a little less ide-
ally, 1024x768).  Higher, lower, or non-
standard resolutions may result in sub-optimal 
image display. 
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Should I do a Full Install of Future Boy! or a 
Minimal Install? 
A Full Install is highly recommended for best 
playing response for graphics-capable systems 
in order to copy all game data  from the CD-
ROM to your computer’s hard disk.  (When 
playing Future Boy! in text-only mode, only a 
Minimal Install is necessary.) 
 

Whenever I start the game, my colors/fonts/other 
options are all mixed up. 
Try any “Restore Defaults” for fonts or col-
ors that your version of the Hugo Engine 
provides.  You might also try deleting any ex-
isting game settings:  the FBConfig file (if it 
exists) may be found in the game directory, 
the Hugo Engine program directory, or your 
home directory, depending on your system. 
 
Where can I go for technical support? 
Please visit www.generalcoffee.com/futureboy. 

 
System-Specific Troubleshooting: 

 Windows – There is no sound and/or video 
playback and/or the Hugo Engine (hewin.exe) 
crashes with an error reported in QUARTZ.DLL, 
DSOUND.DLL, or another module. 
Make sure that you have installed the latest 
version of DirectX, which can be obtained 
from www.microsoft.com/directx.  (The latest ver-
sion as of Future Boy!’s release is included on 
the game’s CD-ROM.)  Ensure that all video 
drivers, sound card drivers, etc. for your sys-
tem are up to date.  If the problem persists, 
check to see that no other programs are run-
ning. 
 

 Macintosh – Images fail to display properly on 
OS 9 and/or the window doesn’t properly repaint, 
particularly with a larger window size. 
Increase the memory allocation in the Finder 
by selecting the Hugo Engine and choosing 
“Get Info” from the “File” menu. 
 

 Linux – The Hugo Engine (hewx) complains 
about being unable to load libraries such as 
libwx_gtk.so, libmikmod.so, etc. 
Not all Linux installations have the same in-
stalled libraries.  Make sure that you’ve com-
piled (if necessary) and installed any required 
libraries.  These are included on the CD-
ROM.  If problems continue after installing, 
ensure that the library path is in 
/etc/ld.so.conf before running ldconfig.  If 
building from source, you may also want to 

make sure  /usr/local/bin is in your path so 
that programs can find the wx-config utility 
at compile-time. 
 

 BeOS – Playback of video seems scram-
bled or otherwise incorrect. 
Please ensure that you are using the official 
R5 Media Kit.  Unofficial releases of the op-
erating system, Media Kit, or required codecs 
are not supported. 
 

 Palm – The device runs out of memory when 
starting or saving a game. 
Especially with handheld devices, more mem-
ory is preferable.  During play, Future Boy! may 
require up to 1 MB for the program, the 
game data, and other memory use.  Addi-
tional storage is required for saving games.  
Remove any unused programs or data from 
the device before playing. 
 

 Windows CE/Pocket PC – The game’s 
display does not seem to be formatted properly, or 
menus are not displaying properly. 
In order for Future Boy! to work with the lim-
ited screen size of your device, it is recom-
mended that “Minimal Windows” be turned 
off.  You may also reduce the size of the 
fixed-width font.  Both of these can be done 
from the Options menu. 
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TRAVEL 
 
>GO WEST 
 

 
The Rocket City Chamber of Commerce invites 
visitors to enjoy all the sights and splendors of 
Rocket City, from its stunning coastline and the 
old-fashioned allure of Duke’s Supper Club to the 
bustling commerce of the city’s warehouse dis-
trict and the cosy, crowd-pleasing gothic charm of 
Shankrock Prison.  Call the Chamber office today 
for maps, walking tours, and tourist information. 

 
PAID ADVERTISEMENT 

by the Rocket City Chamber of Commerce 
 
The Game Interface 

 
 

The Main Text Area is where most of 
the action happens.  This is where descrip-
tions, action, and dialogue are printed, and 
the story unfolds.  It is also where you enter 
typed commands at the Player Input 
prompt.  The Status Line at the top of the 

displays the name of the current location as 
well as the time of day. 

On graphics-capable platforms, the game 
text is enhanced by one or more comic-book-
like panels.  The Main Image typically pro-
vides an illustrated overview of the current 
location.  One or more small panels may dis-
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play Detail Images showing close-up views 
of objects or characters.  Finally, the Orien-
tation compass indicates which way the Main 
Image is facing (where applicable). 

If available, the optional Compass Rose 
floats above the game’s display during play, 

and may be clicked for convenient directional 
navigation.  The popup Context Menu pre-
sents a quick-reference list of selectable ac-
tions relevant to the current location or situa-
tion.  Not all platforms provide the compass 
rose and/or context menus. 

 
Getting Around 

Most of what you’ll end up doing in this 
story will take the form of simply “verb”, or 
“verb the something”, or even “verb the 
something with the something else”.  

You can start by moving around.  Try 
“go north”, “go south”, “walk west”, “go 
up”, etc. (or “n”, “s”, “w”, and “u” for 
short).  If there’s a house in front of you, try:  
“enter the house” or “go inside”.  A closed 
door might be remedied with “open the 
door”, and a set of stairs deserves:  “climb 
the stairs”.  That sort of thing.  Use your 
imagination; if the game doesn’t understand 
what you mean, it’ll be sure to let you 
know—and if the game tells you it doesn’t 
understand a particular word, you can assume 
that word isn’t necessary to the story. 

Additionally, you can “get” and “drop” 
things you might find about the landscape.  
Check what you’re carrying with “take inven-
tory” or just plain “i”.  You can examine 
things (using “examine” or “x”), try to open 
them, taste them, show them around, throw 
them  at other objects or people—whatever 
comes to mind.  You can be as  descriptive as 
you like about where you’d like to go or what 
you’d  like to do, since the story understands 
everything from one-word commands to 
complete English sentences. 

You can wait around—i.e., “wait” (or 
simply “z”), “wait until 11:30”, “wait for 10 
minutes”, “wait for someone”—or, if you 

want, repeat your last command just by typing 
“again” or “g”.  If you make a mistake in 
your typing, and the story complains that it 
doesn’t know the misspelled word, you may 
easily atone by typing “oops” (or “o”) fol-
lowed by the properly spelled word.  Try 
“objectives” or “goals” if you’re not sure 
exactly what it is you’re supposed to be doing, 
and “score” to get an idea of how you’re far-
ing in terms of getting there.  If you misplace 
something, try “where is something” to see 
where you might have left it. 

At any point in the game, you can freeze 
your state of affairs using the “save” com-
mand.  You can pick up again later from this 
same point by typing “restore”.  In fact, it’s 
recommended to save periodically, particu-
larly after any important accomplishments.  
Any story that takes a radical turn for the 
worse can be  started again from the begin-
ning with “restart”.  (And you can take back 
a move that, in hindsight, might not have 
been the smartest possible thing to try by typ-
ing “undo”.  Be warned, however, that only a 
finite number of undos in a row is allowed—
you can’t trace your steps all the way back to 
the beginning every time.) 

Helpfully, you’re also able to start or stop 
recording a transcript of your story with 
“script on” and “script off”, enabling you to 
have all the text as it’s printed on the screen 
to be saved for reading later. 

 
 

    Windows, Macintosh, 
Linux, BeOS – Right-clicking with the 
mouse (or clicking-and-holding, for one-
button mice) during player input will bring up 
a context menu of actions for quick selection.  
These actions will change depending on the 
current situation/location—please also note 
that these are far from all the valid actions at 

any given time.  Double-clicking on a word in 
the game text when player input is active (or 
shift-clicking, on Macintosh and Linux) will 
enter that word into the input line.  Use the 
up-and-down arrow keys to cycle through the 
history of your previously used commands.  
When talking to another character, select a 
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conversation choice using either the keyboard 
or the mouse. 
 

   Windows, Macintosh, 
BeOS – From the Hugo Engine menu, you 
can choose to use a compass rose for naviga-
tion.  The compass rose floats above the 
game window:  simply click on a direction 
during player input to go that way. 
 

   Windows, Macintosh, 
BeOS – When a movie is playing (as opposed 
to background animation) you can press the 
Escape key to skip it.  (In Windows, you can 
also double-click the movie to skip a movie.) 
 

 Palm – Use the row of directional but-
tons across the bottom of the device display 
for easy one-tap navigation.  The … button 
will display a context menu of actions for 
quick selection.  Tapping … a second time 
will bring up a list of word shortcuts.  Addi-
tionally, tapping on a word in the game text 
will pop up a list of command shortcuts; 
double-tapping a word when player input is 

active will enter that word into the input line.  
The directional buttons, the word shortcuts, 
and the command shortcuts are all user-
modifiable:  press the device’s Menu key, then 
select the Options menu. 
 

 Windows CE/Pocket PC – Use the 
footsteps icon in the command bar to bring 
up a list of directions for easy navigation.  
The … button will display a context menu of 
actions for quick selection.  Tapping … a 
second time will bring up a list of word short-
cuts.  Additionally, tapping on a word in the 
game text will pop up a list of command 
shortcuts; double-tapping a word when player 
input is active will enter that word into the 
input line.  The lists of directions, word 
shortcuts, and command shortcuts are all 
user-modifiable from the Options menu. 
 
Please also see any further platform-specific informa-
tion on the game’s CD-ROM 
 

 
Getting To Know Your Neighbors 

The simplest way to converse with other 
characters is by trying to “talk to someone” 
(or by selecting “Talk to someone” from the 
context menu, if your platform supports it).  
You can also abbreviate “talk to” as “talk” or 
even just “t”.  Then, given that the character 
in question and you have something to say 
from each other, you’ll be given a number of 
choices to choose from to start the conversa-
tion.  These choices will change as the con-
versation progresses.  Sometimes, depending 
on what's been said, a character may finish 
speaking with you--but not necessarily per-
manently.  If you have something else to say, 
try talking to that character again. 

You can also always converse with other 
characters in the game in the “classic adven-
ture-game style” with full English sentences 
using “ask”, “tell”, and “show”.  This way, 
you can even talk about things that don’t 
come up in the conversation menu.  (Note 
that, if you like, you can disable conversation 

menus from the Options menu to converse 
solely using this classic style.) 

“Ask someone about something” is 
probably going to be the most useful to you 
in terms of conversation, since it’s going to 
allow you (well, you hope) to find out what 
you need to know.  If you’re already talking to 
someone, you can just “ask about some-
thing”.  If, on the other hand, you need to 
pass on some knowledge, try to “tell some-
one about something” or, if you’ve got 
something of potential interest handy, you 
can “show something to someone” or 
“give something to someone”.  If a charac-
ter has something you want, you can always 
try to:  “ask someone for something”.  

You may also direct characters to do 
things like:  “someone, open the door” or 
“someone, follow me”.  Whether or not 
they’ll actually want to do it, however, is an-
other question. 
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A Transcript of Play 
 
WARNING:  What follows is a brief transcript of solving the first puzzle in the introduction, and may be helpful 
for first-time players.  It’s recommended, however, that you don’t read this section until after at least playing the be-
ginning of the game and exploring the game environment and interface a little on your own first.  A good part of the 
fun, after all, is in figuring things out for yourself.) 
 
>LOOK 
 
Living room 
  You had plans for setting up the living room 
all nicely, maybe even with a bar and some 
fancy track lighting, but those plans remain 
pretty much unrealized.  The sofa, for in-
stance, sits right where you first put it, in 
front of the old television you bought sec-
ondhand, on which is balanced a VCR.  Be-
hind the sofa is a short wooden table with a 
telephone on it, and there’s an intercom on 
the wall.  You can duck west into the kitchen 
from here, or head the other way out the 
apartment door. 
 
>WHO AM I? 
You’re you.  Nothing fancier than that. 
 
>WHAT TIME IS IT? 
It’s daytime. 
 
>GO WEST 
 
Kitchen 
  The refrigerator hums away in the corner 
beside the stove.  Dirty dishes sit without risk 
of being disturbed in the sink below the cup-
boards.  You can go north into the hallway, 
or east into the living room. 
 
>N 
 
Hallway 
  You’re standing outside your room, which 
you could enter with a couple steps westward.  
Going north will take you down the hall to 
Frank’s room; south leads into the kitchen.  
The bathroom door is to the east. 
  There’s a greenish glow coming from un-
derneath the bathroom door. 

  Sitting on the floor in the hallway is a shoe-
box. 
 
>OPEN DOOR 
You give the door a push, but it doesn't open, 
almost as if something is keeping it shut.  Or 
as if it's just a little too big for the frame.  
And now that you notice it, the door is warm. 
 
>OPEN SHOEBOX 
Opened. 
 
Inside the shoebox is an airhorn. 
 
>N 
(opening Frank’s bedroom door first) 
Opened. 
 
Frank’s bedroom 
  Frank’s room is pretty much the same as 
yours, just messier.  Frank’s bed (where you 
can currently find Frank himself, asleep) is 
more or less in the middle of a pile of old 
clothes and other stuff you probably don’t 
want to go hunting through.  There’s also a 
desk and chair, night table and phone.  You 
can go south back into the hallway. 
 
>WAKE FRANK 
You try, but it’s useless.  You’ve known Frank 
long enough to know that no amount of pok-
ing, nudging, or “Hey, Frank” is going to get 
him up. 
 
>GOALS 
Current objectives: 
- You should probably be finding out what 
that green glow is. 
- You could start by finding some way to get 
Frank out of bed. 
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>GO SOUTH.  GET THE AIRHORN, 
THEN GO NORTH. 
 
Hallway 
  A shoebox is here.  Inside the shoebox is an 
airhorn. 
 
Taken. 
 
Frank’s bedroom 
 
>BLOW AIRHORN 
You press the button and the airhorn lets out 
an unpleasant (and loud) BLAAAT! noise.  
Somehow Frank manages to sleep right 
through it.  (Nice try, though.  But looks like 
you’re going to have to figure out some other 
way to wake him up.  Something a little closer 
to his heart—or something.) 
 
>S 
 
Hallway 
  A shoebox is here. 
 
>S 
 
Kitchen 
 
>OPEN FRIDGE 
Opened. 
 
On the shelf inside the open refrigerator you 
can see some uncooked bacon. 
 
>TAKE ALL FROM FRIDGE 
uncooked bacon:  Taken. 

 
>LOOK IN CUPBOARDS 
Quite unexpectedly, you find a clean frying 
pan in the kitchen cupboard. 
 
Taken. 
 
>PUT THE BACON IN THE PAN, 
THEN PUT THE PAN ON THE 
STOVE 
You put the uncooked bacon in the frying 
pan. 
 
You put the frying pan on the stovetop. 
 
>TURN ON THE STOVE 
You turn on the stove.  The hiss of the pilot 
light turns with a soft popping noise into a 
steady circle of blue flame around one of the 
burners. 
 
The bacon in the frying pan starts to hiss and 
pop. 
 
>WAIT FOR FRANK 
Time passes... 
 
The smell of frying bacon begins to fill the 
kitchen. 
 
A second later, a sleepy-eyed Frank wanders 
into the kitchen.  “Hey.  You, uh...cooking 
breakfast?” 
 
 

END OF TRANSCRIPT 
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THE ROCKET CITY CITIZEN 

ARTS & LEISURE 
 
RESTAURANT REVIEW: 

SUBSTANCE OVER FORM 
At Duke’s Supper Club 
«« The risk a restaurant critic runs in re-
viewing a local favourite such as Duke’s Sup-
per Club is one of overlooking those particu-
lar qualities that, over the years, have made it 
an institution.  With Duke’s, fortunately, there 
is no such risk.  Everyone from patrons to 
the staff readily agrees that it pretty much has 
one thing in its favor:  its convenient location. 

Typical pub fare includes fish-and-chips 
(emphasis on the generic “fish”), shepherd's 
pie, and a rather too-hearty meatloaf, all pre-
pared with sub-typical aplomb  The premium 
imported pale ale is—how best to put it?—
not.  Still, albeit by a narrow margin, it is sub-
stance over form:  pedestrian taste and rib-
stickingness win out over the aesthetically un-
encouraging presentation.   

But the staff is amicable enough, and yes, 
the location is convenient.  (Price:  Inexpensive) 

« « « 
THE CIRCUS IS COMING 

TO TOWN! 
« « « 

 

Come One, Come All! 
 

The circus is FUN for everyone! 
 

COMING SOON! Watch For Details! 
 

Attendees acknowledge that performances may include 
any or all of:  elephants, tigers, monkeys, pyrotechnics, 
cannons, people shot out of same, clowns, seltzer bottles, 
flying seltzer bottles, flying clowns, surly clowns, highwire 
clowns, highwire sword jugglers, surly sword jugglers, 
trapeze acts, trick riders, possible tent collapse, and 
strobe lights; and therefore attend at their own risk.  
Management assumes no responsibility for personal in-
jury, accidental or intentional.  Cotton candy is for 
amusement purposes only and not intended for human 
consumption. Signed waiver required for admission.  
Several purchases necessary.  No refunds or exchanges.  
Void where prohibited by law. 

NOW PLAYING 

Call for Theaters and Showtimes 
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TODAY’S CROSSWORD 
 
 

 
Across 
4. Abbreviated PTL 
5. Talkative cellmate 
7. Shorter, curmudgeonly visitor 
9. A place for a cup of coffee 
10. A pet name 
13. Not a small ship at all 
18. Light as a feather, but squishier 
19. Your round friend who’s fun to be with 
20. Supervillain extraordinaire 
21. Keeps prying eyes from logging in 
24. Visit Sunny _____ _____ 
25. Every child loves the _____ 
27. Find her at the local tavern 
28. Home Sweet Home—just not Earth 
29. Supper Club 

Down 
1. Worth more than its weight in gold 
2. Arrives in 13 across 
3. Mechanized wardrobe 
6. Has bad luck with men, particularly criminals 
8. The only way out of town 
11. Handy digital device (even for games) 
12. Big, hungry, and extinct 
14. Prison 
15. Larger, green visitor 
16. Lives in a fishbowl 
17. It’s round like a ball 
20. A tasty snack for 12 down 
22. 20 across’s muscle 
23. _____ fortress—every supervillain worth his 

salt has one 
26. A roommate 
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CLASSIFIEDS 
 
REAL ESTATE 
White House for sale—small grue problem—
a perfect fixer-upper.  Relaxing forest locale, 
pleasant songbirds.  Carpet, lamp, mailbox 
included. 
 
ISLAND AVAILABLE for sale or lease.  
Splendidly isolated.  Perfect for a weekend 
getaway or that compound you’ve been 
dreaming about.  Immediate occupancy. 
 
RENTALS 
ROOMMATE WANTED for two-bedroom 
apartment.  Preferably quiet, clean, financially 
stable. 
 
FOR SALE 
ARMY SURPLUS SALES—Everything from 
boots to canteens to handy troop transports 
at low, low prices.  Discover fabulous bar-
gains on used military equipment at an army 
surplus sale today! 
 
FREE to good home:  adventure games and 
interactive fiction at www.ifarchive.org. 
 
LOST AND FOUND 
Lost:  bird cage, key, pocket fluff, jewelled 
egg, sword, lariat, key, scythe, map of Paris, 
key.  Found:  several jigsaw puzzle pieces, 
talking skull, bottle of Ebullion, featureless 

white cube, Brass Lantern matchbook, last 
lousy point. 
 
HELP WANTED 
EMPLOYMENT OPPORTUNITY—driver 
for local laundry service.  Low pay, long 
hours, little appreciation.  Call Rocket City 
Laundry today! 
 
Are you a thug?  A henchman?  A flunky or 
minion?  If so, we’re looking for you!  Op-
portunities for crooks and ne’er-do-wells in 
top-shelf criminal organization.  Apply in 
confidence to CE, Box 44. 
 
RELATIONSHIPS 
R U THE 1 4 ME?  Chance meeting.  You:  
in your ship, appearing in a blue glow.  Me:  
wandering the city park late at night, in char-
treuse.  We shared a glance—maybe more?  I 
won’t judge you for being an alien. 
 
NEED HELP?  STUCK? 
In-game hints not quite getting you where 
you need to go?  Visit www.generalcoffee.com or 
the newsgroup rec.games.int-fiction.  Please note 
that The General Coffee Company Film Pro-
ductions is unable to answer individual hint 
requests, but you’ll find other Future Boy! play-
ers who might be willing to help get you un-
stuck. 
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